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Advisor Workstation Training Manual:
Using the Home Page

This document explains how to use Advisor Workstation's Home Page, which can be Overview
found by clicking on the Home tab at the top of Advisor Workstation.

= Note: Your Home Page could differ from what you see here, as each institution decides which
features to display on the Home tab; this manual will cover all possible features.

You will learn about the following:

* \What each widget does on the Home Page
* How to rearrange the widgets on the Home Page, and
* How to hide items on the Home Page.
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Using the Quick Start Widget Overview

Using the Quick Start Widget

This section explains how to make best use of the Quick Start widget on the Home Overview
Page. The Quick Start widget allows you to immediately move to a different area of

Advisor Workstation, without having to first select a module tab or an option from the

left-hand navigation pane.

What is available from

The table below describes the functions you can access from the Quick Start widget: : |
the Quick Start widget?

Option Description

This option brings up the Portfolio Report Builder dialog box. You can select

Portfolio Report either a client’s portfolio(s) or a model portfolio and include up to 10 different

Builder reports for the portfolio and its holdings

This option brings up the Group File dialog box. From here, you can quickly

Group
combine clients or prospects into a group.
Client This option brings up the Client File dialog box. You can immediately create a
new client record from here.
Portfolio This option brings up the Morningstar Quick Portfolio dialog box. You can
either create a new portfolio, or open an existing one.
Custom This option brings up the Morningstar Custom Benchmark dialog box. Here,
Benchmark you can create a new benchmark, or create a blended benchmark
This option brings up the Security Report Builder dialog box. You can
Security Report select a variety of investments (or a list you've previously saved) and

create a tailored report bundle for your client or prospect

This option opens the Advanced Search dialog box. You can either create a
Advanced Search | e\ search, or open an existing one. Note that the universe defaults to
Canadian Mutual Funds.

This option opens the List dialog box. You can create a new list of

List

investments, clients or hypothetical illustrations.

This option opens the Graph dialog box. You need to click the Find/Add
Graph Securities button on the right side of the dialog box to include items for a

graph.

This option brings up the Morningstar Hypothetical lllustration dialog box.
Hypothetical You can either create a new hypothetical illustration, or open an existing

one.
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Using the File Sharing Widget Overview

Using the File Sharing Widget

This section explains how the File Sharing widget works. This widget allows you to Overview
review and accept or decline requests from others who would like to share files with
you.

=F Note: You cannot share files with others by using this Home Page widget. For that, you must go
to the File menu and select File Sharing.

To review, accept or decline a file-sharing request from the Home Page, How to use the File
do the following: Sharing widget

1. Use the drop-down field to search for requests from the past week, month or all time.
2. When you see an item listed in the File Sharing widget, click Pending. The File Sharing
dialog box appears.

File Sharing -

The following people would like to give you access to their files.
Fleaze click on the Pending link to view the details and approve .
or decline the request. Click once on the

All v Pending link to

Date Owmner Status rEViEW the request
01-08-2010 Amy Ost Pending

3. Toaccept the request, click Approve. To reject the request, click Decline. The dialog
box will close, and the status on the Home Page will update to reflect your choice.

File Sharing - Amy Ost *

The file owner would like to give you access to his/her
| files. Please approve or decline the request, or click
' Cancel to keep the pending status. You will only have

| ' access to files within the modules you are subscribed to.

File Type Permission
Clients & Portfolics:Model Portfolios Read/Wr...
Clients & Portfolios: C&P Lists Read Only

Select one of these options

Approve Decline Cancel
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Using the Recently Modified Files Widget Overview

Using the Recently Modified Files Widget

This section explains how the Recently Modified Files widget works. Overview

The Recently Modified Files widget shows the top 25 recently modified files from
different parts of the Workstation. You can jump immediately to the area (client record,
advanced search, etc.) of Advisor Workstation by using the hyperlinks in this widget

=F Note: Shortcuts available here will vary, depending on your institution's solution.

The file types you see in the Recently Modified Files widget depend on your specific
configuration and/pr permission. You may see the following file types from this
widget:

* Groups

* Clients

* Portfolios

* Client Plans

* Model Portfolios

* Custom Benchmarks
* C&P Lists

* C&P Searches

* C&P Custom Views

* Research Lists

* Research Searches
* Research Custom Views
* Hypotheticals

* Hypo Lists

* Hypo Searches, and
* Hypo Custom Views.

To use the Recently Modified Files widget, do the following: How to use the Recently
Modified Files widget

1. Click the drop-down field and select a file type.
2. Click on the hyperlink for the record you want to open. The corresponding dialog box or

area will open automatically.

Recently Modified Files -
Research Searches v -
Select an option from
File Name Date Modified * the drop-down list
1  Top Large Cap 03-31-2010 then click on the
2 Discount ETFs 12-21-200% hyperlink for an item
3 Small Growth 12-21-2009
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Using the Security Finder Widget Overview

Using the Security Finder Widget

This section explains how to use the Security Finder widget. This tool allows you to Overview
generate a report for one security at a time. This saves time from having to go to the

Research universe (or a client’s portfolio), find the security and generate the report

from there.

Remember that you can search for only one security at a time. How to use the Security
Finder widget

To use the Security Finder widget, do the following:

1. From the Select Universe drop-down field, choose the type of investment you are
looking for.

2. Type the name or ticker in the find field. To find a security based on a portion of the

name, type at least four characters, otherwise the system will use a “begins with”
search.

3. Select the name of the item you want. If the item does not appear in the initial list that

appears, click View full results.

Security Finder -

Select Universe

Canada Mutual Funds w

Type the name of
the item you want
Investment Detail Report v to find here

Select Report

Launch Report

4. Select the desired report type from the Select Report drop down, and click Launch
Report.
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Using the Market Index Overview

Using the Market Index

This section explains what the Market Index is, and how to best leverage it with Overview
clients. The Market Index tool shows you how the various global markets are
performing during a given day..

As seen on the Home Page of Advisor Workstation, the Market Index reflects the Whatis the Market Index?
performance of the Canadian, U.S., Asian, and European markets are performing, with
a 15 minute lag time.

Market Index -
Canada u.s. Asian European
SRP/TSX 12,811 -15.7 -0.1% Data is available
Comp with a 15 minute
M’J‘ lag time

S&P/TSX60 736 -1.2 -0.2%

TSX Venture 1,112 -4.3 -0.4%
The Market Index widget has two pieces of interactivity: if you move your cursor over How do | use the Market
one of the Index’s, the index’s summary chart with pop appears. If you click on the Index widget

market tabs at the top, you will see each markets available indexes.

Market Index -

Canada U.S. Asian European
Shanghai 2,311 @ -8.0 -0.3% C_“C’k ona tabyto
. view a Market's

indexes

Nikkei 225 12,349 65.4 0.5%
Hang Seng 23,091 -1.1 0.0%
BSE 30 19,646 -37.0 -0.2%

All Ordinaries 5,160 22.5 0.4%
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Using the Top Securities Widget

Overview

Using the Top Securities Widget

This section explains how to use the Top Securities widget. This widget will display one
of two pieces of information:

* The top 25 investments for which you generated an Investment Detail Report in the
previous month, or
* The top 25 securities owned in your practice, based on asset size.

1= Note: each of these pages is updated on a separate schedule during month-end processing.

The Investment Detail Reports will be updated on the fourth business day of the month. The
Portfolio data is updated on the 12th business day of the month.

To use the Top Securities widget, do the following:

1. If you want to see portfolio data, select Portfolios from the drop-down field.
2. Scroll to the right to see additional data points. Remember that you can sort the columns
here as you would in any other Advisor Workstation spreadsheet.

Top Securities -

Investment Detail Reports w

Name Tot Ret TotRet TotRet To
¥YTD 3 Month 3 Year 5

Use this drop-down field
= to switch to seeing the
Tt top securities in your portfolios
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How do | use the Top
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Modifying the Home Page

Overview

Modifying the Home Page

This section explains how to modify the widgets on the Home Page. You can do the

following with the Home Page widgets:

* Change their height
* Reposition them, or
* Collapse them.

You can change the height of a widget (i.e., how “tall” it appears), but not its width.

I The widgets will become slightly wider if you collapse the left-hand navigation pane.

To change the height of a widget, do the following:

1. Move your mouse cursor over the bottom border of a widget. The bottom border and

cursor will change.

Note how bath the bottom border
and mouse cursor have changed

| Quick Start

| &) Portfolio Report Builder ¥ Advanced Search

| 22 Group W Security Report Builder
| @ client E| List

| & Portfolio ~& Graphs

| 1Y Custom Benchmark B Hvpothetical

[ 2% Investment Proposal Bl Library

2. Left-click and drag the border down (or up) to change the height of the widget.
3. Release the left mouse button when finished. The new height will be saved until you

change it.

Overview

How do | change the
height of a widget
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Modifying the Home Page How do | reposition the widgets on the Home Page?

You can change where each widget appears on the Home Page. Note that this updated ~ How do | reposition the

setting will be saved. To reposition the widgets on the Home Page, do the following: widgets on the Home

_ _ _ Page?
1. Move your mouse cursor over the title bar for a widget. The cursor will change to a four- g

headed arrow.
2. Left-click and drag the widget. You will see an outline of the widget as you begin to move
it to the new location.

Quick Start - Market Index -
Portfolio List - Canada u.s. Asian -
& Report Builder = ==
& Group & Graphs S&P/TSX 12827 1
= = Hypothetical E Comp T
O H imilar Funds
Tradua Tends M Note the silhouette
[ funddame (- A~ ; ;
v = 5 of of the widget as it
Security Finder - is dragged toanew
select univarse LopSecutics & - location

Canada Mutual Funds

Please enter security nar

PDFf

File Sharing

The following people wi
access to their files. Ple
pending link to view the de
or decline the request.

3. When you have the widget in the position you want, release the left mouse button.

While you cannot completely remove a widget from the Home Page, you can collapse it How do I hide a widget?
such that its content is not seen. To collapse a widget, click the arrow icon in the

upper-right corner of the widget's title bar. You can expand the widget by clicking the

same icon again.

Recently Modified Files -
Groups - Click this icon
File Name Date Modified « to coIIapse a Widget

1 Boris Family 03-01-2013

2 Holden Family 11-29-2012

3 Test Family 10-03-2012

4 Anikos Family 09-17-2012

5 Stern Family 08-23-2012

6 Alan's Family 08-17-2012

7 Joe Family 08-17-2012

8 Stephanie's Family 07-30-2012

Recently Modified Files I

Click the same icon
to expand a collapsed
widget
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